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About This Guide

Purpose
The manual shows how to use Cisco Intelligent Contact Management (ICM)
configuration tools to configure and maintain the ICM database. 

For how to create and manage ICM scripts, see the Cisco ICM Enterprise Edition 
Scripting and Media Routing Guide. For specific information on an ACD or NIC,
see the appropriate Cisco ICM software ACD or NIC supplement documenta
or ask your customer representative for that documentation.

Audience
This document is intended for Cisco ICM system administrators. A system 
administrator should have a general understanding of call center operations
management and specific information about the call centers and carrier networks
connected to Cisco ICM software.
xiii
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About This Guide
Organization
Organization
The manual is divided into the following sections.

Chapter Description

Chapter 1, “Overview” Describes the Cisco ICM system and introduces 
the Admin Workstation Group set of tools.

Chapter 2, “How Routing 
Works”

Describes how ICM software interacts with the 
interexchange carrier (IXC) signaling network and 
your call centers.

Chapter 3, “The ICM 
Configuration Manager”

Describes the ICM Configuration Manager tool 
and how to use it to define and maintain 
information about your enterprise in the ICM 
database.

Chapter 4, “Configuring 
Multiple Records at a 
Time”

Explains how to configure multiple records at a 
time.

Chapter 5, “Configuring 
Routing Clients”

Explains how to define your routing clients.

Chapter 6, “Configuring 
Peripherals and Trunk 
Groups”

Explains how to define your peripherals, trunk 
groups, and dialed numbers.

Chapter 7, “Configuring 
Skill Targets”

Explains how to define the services, skill groups, 
and agents associated with each peripheral.

Chapter 8, “Configuring 
Routes and Routing 
Targets”

Explains how to define the routes and targets 
within your system.

Chapter 9, “Configuring 
ICM Software for 
Integrated Applications”

Describes how to configure multimedia 
applications in ICM software.

Chapter 10, 
“Configuring ICM 
Variables”

Describes the ECC and user variables and how to 
define and use them.
xiv
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About This Guide
Conventions
Conventions
This manual uses the following conventions.

Chapter 11, “Network 
IVRs/VRUs”

This chapter discusses the Network IVR/VRU 
feature that lets you divert a call to an interactive 
voice response unit for additional processing.

Appendix A, “Configure 
ICM Tools”

Shows how the Configure ICM menu in ICM, 
version 4.5, is mapped to the new Configuration 
Manager tools in ICM, version 4.6.

Chapter Description

Format Example

Boldface type is used for user 
entries, keys, buttons, and folder 
and submenu names.

Start the ICM Configuration Manager and 
select Tools > List Tools > Expanded Call 
Variable List .

Italic type indicates one of the 
following:

• A newly introduced term

• For emphasis

• A generic syntax item that 
you must replace with a 
specific value

• A title of a publication

• A skill group is a collection of agents 
who share similar skills.

• Do not use the numerical naming 
convention that is used in the 
predefined templates (for example, 
persvc01).

• IF (condition, true-value, false-value)

• For more information, see the Cisco 
ICM Enterprise Edition Database 
Schema Handbook.

An arrow ( > ) indicates an item 
from a pull-down menu.

The Save command from the File menu is 
referenced as File > Save.
xv
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About This Guide
Other Publications

co 

 

tion 
Other Publications
For additional information about Cisco Intelligent Contact Management (ICM) 
software, see the Cisco web site listing ICM documentation.

Obtaining Documentation
The following sections provide sources for obtaining documentation from Cis
Systems.

World Wide Web
You can access the most current Cisco documentation on the World Wide Web at
the following URL:

http://www.cisco.com

Translated documentation is available at the following URL:

http://www.cisco.com/public/countries_languages.shtml

Documentation CD-ROM
Cisco documentation and additional literature are available in a Cisco 
Documentation CD-ROM package, which is shipped with your product. The 
Documentation CD-ROM is updated monthly and may be more current than 
printed documentation. The CD-ROM package is available as a single unit or 
through an annual subscription.

Ordering Documentation
Cisco documentation is available in the following ways:

• Registered Cisco Direct Customers can order Cisco Product documenta
from the Networking Products MarketPlace:

http://www.cisco.com/cgi-bin/order/order_root.pl
xvi
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• Registered Cisco.com users can order the Documentation CD-ROM through
the online Subscription Store:

http://www.cisco.com/go/subscription

• Nonregistered Cisco.com users can order documentation through a loca
account representative by calling Cisco corporate headquarters (California,
USA) at 408 526-7208 or, in North America, by calling 800 
553-NETS(6387).

Documentation Feedback
If you are reading Cisco product documentation on Cisco.com, you can subm
technical comments electronically. Click Leave Feedback at the bottom of the 
Cisco Documentation home page. After you complete the form, print it out a
fax it to Cisco at 408 527-0730.

You can e-mail your comments to bug-doc@cisco.com.

To submit your comments by mail, use the response card behind the front co
of your document, or write to the following address:

Cisco Systems
Attn: Document Resource Connection
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance
Cisco provides Cisco.com as a starting point for all technical assistance. 
Customers and partners can obtain documentation, troubleshooting tips, an
sample configurations from online tools by using the Cisco Technical Assistance
Center (TAC) Web Site. Cisco.com registered users have complete access to th
technical support resources on the Cisco TAC Web Site. 
xvii
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Cisco.com
Cisco.com is the foundation of a suite of interactive, networked services that 
provides immediate, open access to Cisco information, networking solutions, 
services, programs, and resources at any time, from anywhere in the world.

Cisco.com is a highly integrated Internet application and a powerful, easy-to-u
tool that provides a broad range of features and services to help you to

• Streamline business processes and improve productivity 

• Resolve technical issues with online support

• Download and test software packages

• Order Cisco learning materials and merchandise

• Register for online skill assessment, training, and certification programs

You can self-register on Cisco.com to obtain customized information and service
To access Cisco.com, go to the following URL:

http://www.cisco.com

Technical Assistance Center
The Cisco TAC is available to all customers who need technical assistance with 
Cisco product, technology, or solution. Two types of support are available thro
the Cisco TAC: the Cisco TAC Web Site and the Cisco TAC Escalation Cente

Inquiries to Cisco TAC are categorized according to the urgency of the issue:

• Priority level 4 (P4)—You need information or assistance concerning Cis
product capabilities, product installation, or basic product configuration.

• Priority level 3 (P3)—Your network performance is degraded. Network 
functionality is noticeably impaired, but most business operations contin
xviii
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• Priority level 2 (P2)—Your production network is severely degraded, 
affecting significant aspects of business operations. No workaround is 
available.

• Priority level 1 (P1)—Your production network is down, and a critical impa
to business operations will occur if service is not restored quickly. No 
workaround is available.

Which Cisco TAC resource you choose is based on the priority of the problem
the conditions of service contracts, when applicable.

Cisco TAC Web Site

The Cisco TAC Web Site allows you to resolve P3 and P4 issues yourself, saving 
both cost and time. The site provides around-the-clock access to online tools, 
knowledge bases, and software. To access the Cisco TAC Web Site, go to th
following URL:

http://www.cisco.com/tac

All customers, partners, and resellers who have a valid Cisco services contract 
have complete access to the technical support resources on the Cisco TAC Web
Site. The Cisco TAC Web Site requires a Cisco.com login ID and password. If yo
have a valid service contract but do not have a login ID or password, go to t
following URL to register:

http://www.cisco.com/register/

If you cannot resolve your technical issues by using the Cisco TAC Web Site,
you are a Cisco.com registered user, you can open a case online by using the
Case Open tool at the following URL:

http://www.cisco.com/tac/caseopen

If you have Internet access, it is recommended that you open P3 and P4 cases
through the Cisco TAC Web Site.

Cisco TAC Escalation Center

The Cisco TAC Escalation Center addresses issues that are classified as priority 
level 1 or priority level 2; these classifications are assigned when severe netwo
degradation significantly impacts business operations. When you contact the TA
Escalation Center with a P1 or P2 problem, a Cisco TAC engineer will 
automatically open a case.
xix
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To obtain a directory of toll-free Cisco TAC telephone numbers for your coun
go to the following URL:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml

Before calling, please check with your network operations center to determine the 
level of Cisco support services to which your company is entitled; for examp
SMARTnet, SMARTnet Onsite, or Network Supported Accounts (NSA). In 
addition, please have available your service agreement number and your produc
serial number.
xx
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Overview

This chapter provides the following information:

• An introduction to the Intelligent Contact Management (ICM) software an
its components

• An introduction to the ICM Admin Workstation tools

• A summary of system management tasks

ICM Software
Cisco Intelligent Contact Management (ICM) software provides enterprise-wide
distribution of multi-channel contacts (inbound/outbound telephone calls, We
collaboration requests, e-mail messages, chat requests) across geographically 
separated contact centers. ICM software is an open standards based solution 
whose capabilities include routing, queuing, monitoring, and fault tolerance. I
software forms the basis for the Cisco Customer Contact Suite.

ICM software functions across environments as well as across channels.

ICM software functions in the older environment of telephone calls delivered ove
TDM line, of hardware ACDs and IVRs, and of call centers centralized around the
hardware. ICM software can route calls for a single 800 number or for several 
different numbers. ICM software reads information about each incoming call 
from the public network, determines the best destination for that call, and ret
information to the public network instructing it where to route the call. This is
known as call-by-call routing.
1-1
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ICM software makes routing decisions by executing scripts that can easily be 
modified. These scripts can use real-time information about activity at the contact 
centers to find the destination best able to handle the call. You can monitor 
the system is handling calls and can make changes to the scripts when needed.

ICM software functions in the newer environment of multi-channel contacts 
delivered through IP connections, of software ACDs and IVRs, and of contac
centers that can be as decentralized as the Internet or as centralized as business
practices—not hardware necessities—require them to be.

And ICM software functions in the mixed transition environment that involves all
of the above.

Components
The ICM software consists of several components:

• The Central Controller includes the computer that runs the Call Management
process which makes the actual routing decisions and a central database th
stores information about the entire system. The Central Controller consis
one or more computers.

• The Network Interface Controller (NIC) connects to the IXC signaling 
network. ICM software both receives routing requests and returns response
through the NIC.

• A Peripheral Gateway (PG) is typically located in each contact center and 
connected to each peripheral (ACD, PBX, IVR, or Call Manager). The PG 
reads information from the peripheral, converts it into the format used by
ICM software, and forwards it to the Central Controller.

• An ICM Admin Workstation can be located anywhere on the wide area 
network. The ICM Admin Workstation allows you to monitor the activity o
the system or a part of the system. It also allows you to update the routing 
scripts or ICM configuration data.

Figure 1-1 shows the connections within ICM software and between ICM 
software and the IXC signaling network and contact center peripherals. 
1-2
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Figure 1-1 ICM Software Connections

The following subsections give further information about the connections.

Central Controller to IXC Signaling Network

The NIC provides a two-way interface between the Central Controller and the 
telephone signaling network. This allows ICM software to make routing decisions
for each call before the IXC delivers it to a contact center. This is called 
Pre-Routing®.

The NIC reads call routing requests from the signaling network and forwards
them to the Central Controller for processing. Each request includes the numbe
dialed, the caller’s billing telephone number, and any caller-entered digits (CED
received by the network.
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SS7
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When the Central Controller has determined a destination for the call, it returns 
the routing information to the NIC. The NIC then passes the information to th
IXC signaling network.

The ICM software serves as a routing server for the IXC signaling network while 
the IXC serves as a routing client to the ICM software.

Central Controller to Peripheral Gateways

Each contact center has a Peripheral Gateway (PG) to read information from the
site’s phone system and relay that information to the Central Controller. The
reads information from the local peripheral (an ACD, PBX, IVR, or Call 
Manager). This includes information about agent availability, maximum and 
average caller wait times, and so on. The Peripheral Gateway then forwards
information to the Central Controller.

This information serves two purposes within the Central Controller:

• The router can use this information to determine where to route incomin
calls. 

• Users of ICM Admin Workstations can use this to monitor the performan
of part or all of the system.

Optionally, the ICM software can make routing decisions in response to requ
from each contact center (for example, for intelligent agent-to-agent transfers or 
transfers from a voice response unit). This is called Post-Routing®. If 
Post-Routing is enabled, then Peripheral Gateways can also pass routing req
to the Central Controller and receive routes in return. In this configuration, th
ACD, PBX, or Call Manager serves as a routing client to the ICM software.

Central Controller to ICM Admin Workstations

Users at ICM Admin Workstations can read information from the Central 
Controller and can send the Central Controller changes to the system 
configuration or to the routing scripts.

The Central Controller includes a database that stores both information collected
from the Peripheral Gateways and information that the Central Controller ha
accumulated about calls it has routed. You can monitor this information to 
measure the performance of the system as a whole or of a specific site or group.
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ICM Routing Targets
ICM software can route a call to a carrier resource such as an announcement or 
a target at a peripheral. A peripheral, such as an ACD, PBX, or Call Manage
dispatches calls within a contact center.

Peripheral Targets

Depending on the capabilities of the peripheral and the type of routing 
instructions you use, ICM software might choose a specific agent at the peripher
to handle the call. In that case, the peripheral merely dispatches the call to the 
chosen agent. In other cases, ICM software might specify only a group of agents
or a type of service to be provided to the caller. That is, ICM software can route 
to three types of peripheral targets:

• Agent. A specific individual who receives calls through the peripheral. (IC
software, however, cannot guarantee that the specific agent will be available
when the call arrives.) The Queue to Agent node allows the targeting of a 
(the work performed by an agent) to a script-specified agent. This node 
enables an agent to receive and operate on more than one task at a tim

• Skill group. A group of agents who share a common set of skills and wh
can, therefore, all handle specific types of calls. Each skill group contains one
or more agents. If supported by the peripheral, each agent can be a membe
of more than one skill group.

• Service. A type of processing the caller requires. For example, a periphe
might have services defined for sales, technical support, or opening new
accounts. Each service has one or more skill groups whose members ca
provide the service. Each skill group can be associated with more than one
service.

In the last two cases, the peripheral must choose a specific agent within the group 
who can provide the service. In each case, the peripheral plays a key role in 
completing the routing that ICM software has determined. Therefore, ICM 
software and the peripheral must be set up to complement each other. They
have the same understanding of the agents, skill groups, and services available a
each site.

For specific information about how ICM software routes a call and its 
coordination with peripherals, see Chapter 2, “How Routing Works.”
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Scheduled Targets

Some routing clients also support scheduled targets. A scheduled target is a group
of agents not associated with a Peripheral Gateway. ICM software cannot mo
the group directly. Instead it relies on a periodic schedule to determine the num
of agents logged on to the group. The routing client informs ICM software when 
a call to the group ends. Since ICM software knows how many calls it has ro
to the group, it can determine the number of calls in progress. Based on this
the schedule, ICM software can determine whether the target can handle an
additional call.

Peripherals
Different peripheral manufacturers use different terminology for agents, skill 
groups, and services. For example, a service might be called an application, split, 
or gate. A skill group might be called an agent group or hunt group.

Table 1-1 summarizes the mapping of ICM terminology to ACD-specific 
terminology.

Table 1-1 ICM Software and Peripheral-Specific Terminology 

ICM Term Peripheral-Specific Equivalent

Agent Agent

Peripheral 
target

Alcatel 400: DNIS 
Ericsson ACP1000: Trunk group or queue 
NEC NEAX 2400, NEAX 7400, APEX 7600: Pilot number 
Nortel DMS-100, DMS-500, and SL-100: Primary or 
Supplementary ACD DN 
Rockwell Galaxy: DNIS 
Siemens Hicom 300/E: Destination ACD 
Others: Trunk group and DNIS1 
1-6
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Service Alcatel 400: Pilot 
Aspect Contact Center: Application 
Ericsson ACP1000: Trunk group/called number 
Avaya DEFINITY ECS: Vector Directory Number (VDN) 
NEC NEAX 2400, NEAX 7400, APEX 7600: CCV number 
Nortel DMS-100, DMS-500, and SL-100: Primary or 
Supplementary ACD DN 
Nortel Meridian 1 : ACD Directory Number (ACD DN) or 
ACD Controlled Directory Number (ACD CDN)2

Rockwell Galaxy: Gate 
Rockwell Spectrum: Application 
Siemens Hicom 300/E: ACD Routing Table (ART) 
Siemens Rolm 9005: Pilot number for ACD routing table

Skill group Alcatel 400: Agent PG 
Aspect Contact Center: Agent group 
Ericsson ACP1000: Agent group 
Avaya DEFINITY ECS: Skill group or hunt group3

NEC NEAX 2400, NEAX 7400, APEX 7600: Split number 
Nortel DMS-100, DMS-500, and SL-100: ACD Group 
Nortel Meridian 1 : ACD DN 
Others: Skill group

Trunk Alcatel 400: None 
Aspect Contact Center: Instrument4 
Nortel DMS-100, DMS-500, and SL-100: None 
Nortel Meridian 1 : Member of route 
Others: Trunk

Trunk group Alcatel 400: None 
Nortel DMS-100, DMS-500, and SL-100: None5

Nortel Meridian 1 : Route 
Others: Trunk group

1. The Aspect contact center maps a trunk group and DNIS to a Call Control Table (CCT). The 
DEFINITY ECS uses the trunk group and DNIS for incoming calls.

2. Without Customer Controlled Routing (CCR), one or more services map to an ACD DN. With 
CCR, one or more services map to an ACD CDN.

3. If an ECS is running in Expert Agent Selection (EAS) mode, a skill group maps to an ECS skil
group; otherwise, it maps to a hunt group.

Table 1-1 ICM Software and Peripheral-Specific Terminology  (continued)

ICM Term Peripheral-Specific Equivalent
1-7
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Note Multi-channel applications function as application instances. See Chapter 9, 
“Configuring ICM Software for Integrated Applications,” for more 
information about these applications.

In some cases the ICM concept is very close to the corresponding ACD feature.
For example, the ICM concept of a service is very similar to the Aspect concept
of an application. In other cases, the ACD does not have a feature that map
exactly to the ICM feature. In these cases, you might choose a different mapping
than shown in Table 1-1. For example, although it might make sense to associ
each VDN on a DEFINITY ECS with an ICM service, you could also map ea
hunt group to a service.

On a Avaya DEFINITY ECS running in EAS mode and on Rockwell Galaxy 
ACDs, each skill group has primary and secondary subgroups. ICM software
emulates this by automatically creating additional skill groups for these 
peripheral types. For example, when you configure the Sales skill group for 
Galaxy ACD, ICM software automatically creates the Sales.pri and Sales.sec sk
groups in addition to the base Sales group. In monitoring and scripts, you ca
reference the .pri and .sec skill groups directly or you can refer to the base skill
group.

Some ACDs have limitations that prevent them from making full use of spec
features of ICM software. 

See the Cisco ICM Enterprise Edition Pre installation Planning guide for the 
current list of supported peripherals with any peripheral-specific limitations.

The ICM Admin Workstation
An ICM Admin Workstation provides tools and resources for supervisors, system
administrators, and system managers. You can use these resources to:

• Initialize and update configuration information.

• Write and update routing scripts and administrative scripts.

4. A contact center instrument can be a trunk, a teleset, or a workstation.

5. Define one network trunk group and one associated trunk group for each DMS-100, DMS-500, 
and SL-100.
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• Monitor the execution of scripts.

You can also monitor the performance of skill groups, services, routes, and tr
through the ICM Admin Workstation.

The ICM Admin Workstation Group
Each ICM Admin Workstation contains the ICM Admin Workstation group. Th
following tools are available in the group:

• AW Select. Lets you stop and start the services needed to run ICM Admi
Workstation applications.

• Call Tracer. Lets you send test calls to ICM software and see how they a
processed and the target chosen.

• Check Routes. Lets you validate the configuration of routes referenced by
script.

• Configuration Manager. Lets you set up and maintain your environment.
The configuration includes the hardware within the system, the services 
provided by the system, and the agents who provide them.

• Custom Screen Builder. (Option) Lets you create your own report template
for use in Web View.

• Glossary. Defines terms related to ICM software.

• Initialize Local Database. Lets you copy current information from ICM 
software’s central database to the local database on the ICM Admin 
Workstation. (Normally, this is done automatically.)

• Lock Admin. Lets you check or change the status of locks in the ICM 
software central database.

• Print Server. Allows you to automatically print reports at specific times.

• Router Log Viewer. Displays information about calls processed by ICM 
software and any errors encountered in processing them.

• Scheduled Target Manager. Lets you configure and manage scheduled 
targets.

• Schema Help. Describes the structure of the ICM databases.

• Script Editor.  Lets you create, modify, and schedule routing scripts. ICM
software executes these scripts to determine where to route each call.
1-9
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• Service Control. Lets you stop and start ICM-related services.

Note In order to conserve system resources, it is recommended you 
minimize all ICM process windows prior to configuring your system

• Setup. Lets you modify ICM setup parameters.

For more information the Custom Screen Builder, see the Cisco ICM/IP Contact 
Center Enterprise Edition Template Design Guide.

Central and Local Databases
The Central Controller includes a database that stores the system configuration 
information and routing scripts. At least one ICM Admin Workstation (referred to 
as a distributor AW) at each site has its own local database that contains a copy o
data from the central database. Other ICM Admin Workstations at the site can 
read data from the distributor AW’s local database. ICM software’s UpdateAW 
background process automatically keeps the local database synchronized with the
central database.

When you save a change to configuration data or scripts, ICM software 
immediately applies that change to the central database. The UpdateAW proces
copies the change to all local databases.

Lock Administration
To modify a script, you must first obtain a lock on that script. This prevents ot
users from changing the same script until you have saved your changes. Whe
edit a script, the Script Editor automatically acquires a script lock for you. The 
script lock applies to only one script. 

Optionally, you can obtain a master lock that prevents other users from mak
any changes to scripts or configuration data. The master lock is for backwards 
compatibility only. If a user holds the master lock, only that user can make 
changes to any scripts or configuration data. 

To acquire and release a lock, do the following:
1-10
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Step 1 Start Lock Admin  from the ICM Admin Workstation group. The Lock Admin 
dialog box appears, showing the status of all locks.

Step 2 Select the lock by clicking on the Type column of the row describing the lock.

Step 3 Click Release. 

Step 4 Click Close when done.

Configuration Management
ICM configuration information is permanently stored in the Central Controller 
database. ICM software configuration consists of hardware entities, call targets,
announcements, routes, dialed numbers, and regions. Use the ICM Configur
Manager tools to create and modify configuration data. When you apply a cha
in the ICM Configuration Manager, it is immediately applied to the central 
database.

To get started setting up and maintaining your configuration, see Chapter 3, “The 
ICM Configuration Manager.” 

Script Management
After you have set up your configuration, you can write routing scripts and 
administrative scripts:

• A routing script processes a call routing request from a routing client and
determines the best destination for that call. ICM software then passes a labe
associated with the destination back to the routing client. 

• An administrative script runs periodically to perform a task, such as settin
variables. 

Use the Script Editor to create, maintain, and monitor scripts.
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You can set up different routing scripts to execute for different types of tasks. You
can define call types in terms of the telephone number the caller dialed, the 
number the caller is calling from, and additional digits entered by the caller. For
each call type, you can schedule different routing scripts to execute on diffe
days or at different times of the day. Figure 1-2 shows a sample routing script.

Figure 1-2 A Sample Script

A routing script typically examines several targets and applies selection rule
find an available qualified agent or a target with the shortest expected delay. You
can use any of several predefined selection rules or you can set up your ow
selection criteria.
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Within the Script Editor, you can open a script for browsing, monitoring, or 
editing. When you open a script for editing, the Script Editor automatically 
obtains the lock for that script.

To get started using the Script Editor to create or maintain scripts, see the Cisco 
ICM Software Scripting and Media Routing Guide.
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How Routing Works

This chapter describes in detail the process of routing a call. It includes:

• An overview of the routing process

• A description of routing requests and routing clients

• Information about how calls arrive at targets

• An overview of translation routes

• The importance of timeouts and thresholds

Understanding this process will help you set up the configuration of your ICM 
software and create effective scripts.

The Routing Process
To properly route calls, three independent systems must work together:

• The routing client

• ICM software 

• The peripheral that ultimately receives the call

The routing client requests a route from ICM software, receives a response, and
delivers the call to the specified destination. 

ICM software receives routing requests and determines the appropriate 
destination for the call. The destination is an announcement (which is played by
the routing client), a scheduled target, or a specific target at a peripheral 
(represented by a trunk group and DNIS). 
2-1
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A peripheral is a switch at a call center, such as an ACD, a PBX, or Call Manag
The peripheral completes the routing by dispatching the call to the specific target 
determined by ICM software.

The process of routing a call consists of the following steps:

Step 1 A routing client requests a route from ICM software.

Step 2 ICM software, using information supplied by the routing client, categorizes the 
request as a specific call type.

Step 3 ICM software executes a routing script scheduled for the call type to find a 
destination for the call. The destination can be a routing label, an announcement,
or a skill target: a service, skill group, or agent. (If the script fails to find a 
destination, ICM software uses a default destination based on the dialed numbe

Step 4 If the destination is an announcement, scheduled target, or skill target, ICM 
software maps that destination to a routing label. A routing label is a character 
string value that the routing client maps to a destination trunk group and, 
optionally, a Dialed Number Identification Service (DNIS) value for the call. 

Step 5 ICM software passes the routing label back to the routing client.

Step 6 The routing client interprets the label to find the destination.

Step 7 The routing client dispatches the call to the destination (with the appropriate 
DNIS value, if any).

Step 8 If the call is sent to a peripheral, the peripheral must determine the specific ta
for which the call is intended. The peripheral typically makes this determination
based on the trunk group on which the call arrived and, optionally, the DNIS va
sent with the call. The peripheral then completes the routing by dispatching the
call appropriately.

The following sections describe the process in detail.
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Routing Requests
ICM software receives routing requests from routing clients. A routing client ca
be either an interexchange carrier (IXC) or a peripheral. Routing clients are 
classified by type, where type is either the specific IXC (for example, AT&T, 
MCI, or Sprint) or the specific type of the peripheral (for example, VRU or a 
specific type of ACD).

Routing clients send messages to ICM software. One type of message is a route
request. In this case, given a call, the routing client asks ICM software for a 
destination, or route, for that call. If the routing client is an IXC, this is the on
type of message that it sends.

Routing requests are of two types: Pre-Routing and Post-Routing. A Pre-Routing 
request is sent by an IXC to determine the initial destination for a call. A 
Post-Routing request is sent by the peripheral that receives the call to either refine
the original route or to redirect the call.

A routing request includes the following information about the call to be routed:

• Dialed Number (DN). The number the caller dialed.

• Calling Line ID (CLID). The caller’s billing telephone number. This value
is also referred to as Automatic Number Identification or ANI.

• Caller-Entered Digits (CED). Digits the caller entered on a touch-tone 
phone in response to prompts.

Post-Routing messages vary depending on the type of the peripheral.

Targets
A target is the destination for a call. The target can be either a label, an 
announcement defined by the routing client, or a target at a peripheral.

On a high level, a target at the peripheral is a service, skill group, or individu
agent that ICM software selects to handle the call. This is called the skill target. 
Regardless of the specific skill target, every call routed by ICM software must also 
be associated with a service. The combination of a skill target and a service is a
route.
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On a lower level, a target represents a network trunk group at the peripheral and
optionally, a Dialed Number Identification Service (DNIS) value. The routing
client uses this type of target, called a peripheral target, to route the call.

On a still lower level, each peripheral target or announcement maps to a routing
label. A label is a character string that the routing client associates with a spec
peripheral target or announcement.

Figure 2-1 shows the relationships among skill targets, routes, peripheral targets
announcements, and labels.

Figure 2-1 Targets, Routes, and Labels
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ICM software works from the top to the bottom of Figure 2-1:

1. A routing script determines a destination for the call. If the destination is
routing label, then ICM software can return that value directly to the routin
client. Otherwise, the destination is one of the following:

– A skill target to receive the call

– An announcement to be played

– A scheduled target to receive the call

2. If the destination is a skill target, that skill target has an associated route.

3. ICM software uses the route to find an associated peripheral target supported 
by the routing client. 

4. The peripheral target is associated with a label. ICM software returns that 
label to the routing client. If the destination is an announcement, ICM 
software only needs to find the label associated with that announcement an
return the label to the routing client.

The routing client’s processing depends on the type of the label. Some labels 
instruct the routing client to take a special action: playing a busy signal for the 
caller, playing an unanswered ring for the caller, or making a special query. For
normal labels, the routing client converts the label to an announcement, schedule
target, or peripheral target by working up from the bottom of Figure 2-1:

1. The routing client receives a label from ICM software in response to its route 
request. It translates that label into one of the following:

– A peripheral target

– An announcement

– A scheduled target

– An unrouted task that gets routed to a local agent

If the result is an announcement, it plays the announcement for the caller. I
the result is a scheduled target, it delivers the call to that target.

2. If the result is a peripheral target, the routing client delivers the call to the 
specified network trunk group at the peripheral and sends the specified DNIS 
value, if any, with it.

3. The peripheral itself must then recognize the network trunk group and DN
for the call as it arrives and determine the associated service and skill target. 
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The peripheral then completes the process by locating the appropriate agen
handle the call.

ICM System Processing
Figure 2-2 summarizes how ICM software processes a route request.

Figure 2-2 ICM Route Request Processing
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The following subsections describe this processing.

Determine call type

When ICM software receives a route request for a call, it first determines the call
type of the call. A call type is a category of incoming ICM routable tasks. Ea
call type has a schedule that determines which routing script or scripts are active
for that call type at any time.

There are two classes of call types:

• Voice (phone calls)

• Non-voice (for example, e-mail and text chat)

Voice call types are categorized by the dialed number (DN), the caller-entered 
digits (CED), and the calling line ID (CLID).

Non-voice call types are categorized by the Script Type Selector, Application 
String 1, and Application String 2.

In either case, the last two categories of the call type are optional. For voice call
types, the caller-entered digits and the calling line ID are optional, depending
the call. For non-voice call types, Application String 1 and Application String
are optional, depending on the application.

While chat sessions and blended collaboration are different from e-mail and also
require call variables, the call variables are not part of the call type definition

For example, you might define three call types to correspond to three sales re
within the country. You might have a network prompt that lets the caller ente
for sales, 2 for support, and 3 for information. If a call arrives for the dialed 
number 800.486.0029, with a CLID from the 403 (San Jose region) area code
the caller enters 1 (sales) in response to the prompt, that call is classified as 
Western Sales.

If another call arrives with the same dialed number, but with a CLID from the 2
(New York City) area code, and the caller-entered digit 1, that call is classified as
Eastern Sales.

You can define a general default call type and a specific default call type for each
routing client. If the call qualifiers do not map to a specific call type, ICM 
software uses a default call type defined for the routing client. If no default c
type is defined for the routing client, ICM software uses the general default c
type.
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Execute script

Each call type has specific routing scripts scheduled for different times of day and
different days of the year. ICM software finds the script currently scheduled 
the call type and executes it. If that script fails to find a suitable destination (
is, a label, announcement, or skill target) for the call, then ICM software uses a 
default target associated with the Dialed Number value.

If ICM software finds an announcement or scheduled target for the call, then it 
can immediately resolve that to a label to return to the routing client. If ICM 
software finds a skill target for the call, it must perform a few extra steps before
it finds a label.

Determine route

If ICM software finds a skill target for the call, that target has an associated rout
You specify the route when you set up the target within the routing script. A ro
represents the combination of a skill target and a service. That is, a route 
represents the destination for a call and the type of service to be provided to the
caller. Every call routed to a peripheral must have an associated service.

For example, the skill target for a call might be the skill group Denver.PostSales 
and the associated service might be Denver.TechSupport. Another call might also 
be routed to the Denver.PostSales group with the associated service 
Denver.Upgrades.

Note If the destination is itself a service, for example Chicago.Sales, then the 
associated service should also be Chicago.Sales. To associate a service skill targe
with a route for a different service would skew the statistics for those services.

Determine trunk group and DNIS

Once it has determined a route for a call, ICM software finds an associated 
peripheral target (trunk group and DNIS). It is possible to have several periphera
targets associated with the same route, but typically only one of those targe
valid for the routing client. For example, if you have switched access lines, two
IXCs could direct calls to the same trunk group and DNIS, but each requires a 
different label value for that target. Therefore, you need to define two separate 
2-8
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peripheral targets for the route. If more than one peripheral target is associated
with the route, ICM software chooses the first peripheral target that maps to a 
valid label for the routing client.

Determine label

Each peripheral target, scheduled target, or announcement maps to one or more
labels. ICM software finds the first label that is valid for the routing client and
dialed number and returns that label to the routing client. It is then up to the
routing client to interpret the label.

Default label

It is possible that the ICM software might fail to find a call type for a route 
request. Also, the ICM software may execute the script currently scheduled for a
call type and fail to find a destination for the call. In these cases, it uses a de
label that is defined for the dialed number. If no default label is defined for th
dialed number, the ICM software returns an error to the routing client.

The routing client itself also has some default action defined. When you set 
each routing client you can specify the maximum time that client can wait for a 
response to a routing request. If ICM software has not returned a destination for 
the call before the time limit is reached, or if ICM software returns an error, t
routing client performs its own default action.

For more information on timeout limits, see the “Timeouts and Thresholds” 
section on page 2-11.

Routing Client’s Processing
The routing client begins by requesting a route for a call from ICM software. ICM 
software processes the request as described in the preceding section and returns a 
label to the routing client.

The routing client has its own internal mappings for labels to announcement
scheduled targets, and peripheral targets. It uses these mappings to interpret the
label from ICM software:

• Busy. Routing client plays a busy signal for the caller. 

• Ring. Routing client plays an unanswered ring for the caller.
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• Normal and the label maps to an announcement. Routing client plays the 
announcement for the caller. 

• Normal and the label maps to a scheduled target. Routing client delivers the 
call to that target.

• Normal or DNIS Override and the label maps to a peripheral target (that 
is, a trunk group and a DNIS). Routing client delivers the call and the 
specified DNIS value to that trunk group. The peripheral then has 
responsibility for dispatching the call to the appropriate skill target.

The Peripheral’s Processing
When a peripheral receives a call, it determines the trunk group on which the cal
arrived and the DNIS value, if any, associated with it. The peripheral must b
programmed to map these values to the same service and skill target determ
by ICM software.

The peripheral, acting as a routing client, can also send a routing request to ICM
software.

Translation Routes
Sometimes you want to send additional information along with the call to a s
target. Translation routes allow you to do that.

A translation route is a temporary destination for a call. When ICM software 
returns a translation route label to the routing client, it also sends a messag
directly to the Peripheral Gateway (PG) at the targeted peripheral. This messa
alerts the PG that a call will be arriving that requires route translation. The 
message contains the following information:

• The trunk group on which the call will arrive and the DNIS value associated
with it.

• A label to be used by the PG to determine the ultimate skill target of the call.
This is a label that the PG can interpret to find the correct destination.

• Instructions for further processing to be performed by the PG. This further 
processing might include, for example, looking up an account number in
database.
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When the peripheral sees the call arrive on the specified trunk group and with the
specified DNIS value, it passes this information to the PG. The PG then comb
it with the information it has received from ICM software. It then sends the call 
along with this information to the skill target specified by the label it received.
the same time, the peripheral might, for example, send a message to a host 
computer that controls the display on the agent’s workstation. This allows da
such as the caller’s account information, to be displayed on the screen when the 
call arrives. The PG coordinates communication among the network, the 
peripheral, and the computer application that controls the display.

To set up a translation route, you must do the following:

• Set up a translation route associated with the peripheral. You do not need a
separate translation route for each possible skill target at the site, but yo
need at least one for each peripheral that performs translation routing.

• Set up one or more routes and associated peripheral targets for the translation
route. Typically, all peripheral targets for a translation route refer to the same 
trunk group, but with different DNIS values.

• Set up a label for the original routing client for the call to access each of the
peripheral targets associated with the translation route. For example, if the 
routing client is an interexchange carrier (IXC), you must set up a label to the
targets with the IXC. This allows the call to be initially sent to the translation
route at the peripheral.

• For each peripheral target that you want to be able to ultimately access via a
translation route, set a label with the peripheral as the routing client. For
example, you might want to be able to send calls to the Atlanta.Support s
group through a translation route. To do this, you must configure a label
that skill group with the Atlanta peripheral as the routing client. This allows
the peripheral to determine the ultimate destination for the call.

• To display data on the agent’s workstation when the call arrives, you mu
configure the peripheral to inform the PG which agent is receiving the call.

Timeouts and Thresholds
In setting up your configuration, you need to specify several timeout and tim
threshold values.
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For routing clients, you must specify the maximum time ICM software can sp
before responding to each routing request. You must also specify the maxim
time for the routing client to wait for a response before it stops sending new 
requests to ICM software.

For each service at a peripheral, you must specify your goal for the maximum 
a caller must wait before the call is answered. ICM software uses this value in 
calculating the service level.

You can specify how to count abandoned calls in the service level calculation.
can also specify the minimum time a call must be in the queue before it can
considered abandoned.

For specific information about configuring routing clients, peripherals, and 
services, see Chapters 4 through 7. 

Routing Clients
In some cases, a routing client might be unable to receive routing responses
ICM software. Sometimes this affects only a single request, but other times the
routing client loses contact with ICM software for longer periods. You can specify
the amount of time for the routing client to wait before giving up on a single 
request and the amount of time to wait before it stops sending any requests to ICM
software.

Timeout Threshold

The timeout threshold is the amount of time to wait for each routing request.
this value to be the same as the routing client’s timeout threshold. Under no
conditions, ICM software finds a routing label for the call within this limit. 
However, if this threshold is exceeded and ICM software has not yet sent a 
response to the request, the routing client performs its own default action to route
the call. You can specify the timeout threshold in milliseconds. For example,
AT&T ICP connections, set the timeout threshold to 1500 milliseconds.

Late Threshold

You can specify a second threshold, the late threshold, that is shorter than the 
timeout threshold. If ICM software returns a response after this threshold has 
passed, it is considered a late response. The routing client can still use the 
2-12
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response, but it is logged as a late response. A large number of late responses 
might be an early indicator of problems within the system. You can specify th
late threshold in milliseconds. For example, for AT&T ICP connections, set t
late threshold to 500 milliseconds.

Timeout Limit

ICM software is designed to be a highly reliable system. Distributed duplicat
hardware and software fault-tolerance ensure very high availability. However, the 
NIC uses a timeout limit to provide a safety net to ensure that your calls cont
to be routed even if ICM software were to become completely unavailable. If
routing client receives no responses from ICM software within the timeout lim
(and a minimum number of requests have been made), it stops sending reque
ICM software. You can set the minimum number of requests that must be made
(the consecutive timeout limit) when you set up the NIC software. The defau
10.

When a routing request first exceeds the timeout threshold, the NIC for the rou
client starts a timer. If the timer reaches the timeout limit before the routing client
receives any on-time routing responses from ICM software, then the NIC tells the
routing client to stop sending routing requests to ICM software. An on-time 
response is a response within the timeout threshold. You can specify the tim
limit in seconds. For example, for AT&T ICP connections, set the timeout limit
10 seconds.

Abandoned Call Wait Time
When a call is delivered to a peripheral, the caller might be placed in a queue 
waiting for an agent to become available. Normally, if the caller hangs up be
being connected with an agent, the call is considered abandoned. A high numbe
of abandoned calls might mean that you are losing business because callers
being made to wait too long.

However, if a caller hangs up almost immediately after being placed in a queue
you might not want to count that as an abandoned call. In these cases, caller 
impatience or excessive queue times are not the problem; the caller probably 
up for another reason. Tracking these as abandoned calls can be misleading
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Therefore, you can specify a minimum amount of time that a caller must wai
before the call can be considered abandoned. This value is called the abandoned 
call wait time. You can set this value for each peripheral. A typical value might be 
10 seconds. This would mean that if the caller hangs up in the first 10 secon
the call is not considered abandoned, nor is it counted as a call offered. If the 
caller waits at least 10 seconds and then hangs up, the call is counted as both 
offered and abandoned. (In the real-time data, a call is counted as offered as soo
as it arrives at the peripheral. Therefore, a short call might appear as a call offere
in the real-time data, but is not counted as offered in the historical data.)

Service Level
Service level is a measure of how well you are meeting your goals for answer
calls. For each service, you can set a goal for the maximum time a caller spends
in a queue before being connected to an agent. This value is the service level 
threshold. The service level is usually expressed as the percentage of calls that ar
answered within the threshold.

To calculate the service level for a period of time, ICM software determines 
number of calls that have had a service level event within that period. A service 
level event occurs when one of three things happens to a call:

• It is answered within the service level threshold.

• It is abandoned within the service level threshold.

• It reaches the service level threshold without being answered or abando

All calls that have a service level event within a specified period are considered 
as service level calls offered for that period. This differs from a simple call’s 
offered value, which counts each call at the time it is first offered to the service.

Service Level Threshold

The service level threshold is the number of seconds you set as a goal for 
connecting a call with an agent. When you set up a peripheral, you can specify a 
default service level threshold for all services associated with that periphera
When you set up each service, you can choose to either use the default threshold
set for the peripheral or specify a threshold for the service itself in the Servic
Level Threshold field. If you do not specify a service level threshold for an 
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individual service, the default threshold you specified for the peripheral is used
Typically, you should set these values to match the service level thresholds b
used by the peripheral itself.

Service Level Types

Different peripheral types use slightly different formulas to calculate service 
level. ICM software provides a uniform calculation across all peripherals. This 
allows you to apply uniform metrics and performance goals across all peripherals
However, ICM software also tracks the service level as calculated by the 
peripheral itself. This is called the peripheral service level. You can use this value, 
for example, to continue to compare performance to historical norms.

Some peripherals let you select one of several types of service level calcula
You can specify which of these types of service level you want ICM software
track.

The uniform service level calculation performed by ICM software can be done in
any of three ways:

• Abandoned calls ignored. The number of calls answered within the 
threshold divided by the number of calls that had a service level event m
the number of calls that were abandoned before exceeding the service level
threshold. Calls abandoned before the service level threshold expired ar
removed from this calculation.

• Abandoned calls negatively impact service level. The number of calls 
answered within the threshold divided by the number of calls that had a 
service level event. This treats these abandoned calls as though they had 
exceeded the threshold.

• Abandoned calls positively impact service level. The number of calls 
answered within the threshold plus the number of calls abandoned within th
threshold, all divided by the number of calls that had a service level even
This treats these abandoned calls as though they were answered within the 
threshold. 

Figure 2-3 illustrates these different ways of calculating service level.
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Call Counts
Answered within service level threshold: 70
Abandoned within service level threshold: 10
Exceeded service level threshold: 20
Total service level events: 100

Service Level Calculations
Abandoned calls ignored: 70 / (100 - 10) = 77.7%
Abandoned calls negatively impact: 70 / 100 = 70.0%
Abandoned calls positively impact: (70 + 10) / 100 = 80.0%

The value of the Service Level Type field for the service determines how ICM 
software treats abandoned calls. You set this value when you configure the 
service.
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The ICM Configuration Manager

After you have installed ICM and have it running, use the Configuration Mana
to view and update the configuration information in the ICM database. The 
configuration information describes the people, groups, and devices that are
of your enterprise. 

For example, use the Configuration Manager to specify:

• The devices in your system and the clients they serve, including:

– The peripherals at your contact centers 

– The routing clients served by your system

• Targets at the peripherals to which ICM software can direct calls, includi

– Trunks and trunk groups connected to peripherals

– Skill targets associated with each peripheral: agents, skill groups, 
services, and translation routes

– Information used by scripts to organize call requests and direct calls to
targets, including call types, regions, prefixes, and dialed numbers

– Targets understood by the routing client, including announcements, 
peripheral targets, and routing labels

– The associations among routing labels, routes, peripheral targets, a
skill targets

• Enterprise services and enterprise skill groups as a combination of individ
services and groups from different contact centers
3-1
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Accessing the Configuration Manager
To access the Configuration Manager:

• In the ICM Admin Workstation group, double-click the Configuration 
Manager icon 

or 

• From the Start menu, select Programs > ICM Admin Workstation  > 
Configuration Manager.

Configuration Manager 
When you start the Configuration Manager, the Configuration Manager wind
appears. Figure 3-1 shows the window with the top-level directories displayed fo
all its menus. 

The ICM Configuration Manager lets you view and update the configuration 
information in the ICM database. The configuration information describes th
people, groups, and devices that are part of your enterprise.

To set up the configuration of a new system when you are a new user, follow the
steps in the menu bar’s Step by Step Configuration selection list.

Use the tools in the Telephony Contact Center Configuration menu in the or
given to configure, first Network Interface Controllers (NICs), then peripherals
and so on. After you configure ICM software for your telephony contact cent
then you can configure the software for multi-media applications.

The tools in the MultiMedia Contact Center Configuration menu are also in t
order in which you might use them. For example: you must have a media cla
before you can create a media routing domain for that class. And you must 
an application instance before you can specify the path to that application.
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• Access the configuration tools according to the menu selections of the for
Configure ICM tool, in the menu, select Configure ICM .

• Access all the tools you can use in the Configuration Manager, in the me
bar, select Tools.
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Figure 3-1 Configuration Manager
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Online Help
For information about any ICM menu option or other interface features, see the
online help. You can activate help from within ICM software in any of three wa

• Click Help in the tool bar or in the dialog box.

• Choose Help > Help Contents from the menu bar.

• Press the F1 key.

Figure 3-2 Example Help as Viewed from  the Configuration Manager Help Menu
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Troubleshooting
The following section lists problems which may occur when editing records.

Problem: 
If an edit is made and saved in one configuration tool while another configura
tool is open, the edited data will not display in the other configuration tool 
window (or selection boxes) until you click Retrieve. 

Discussion:

Clicking Retrieve not only retrieves data when you first open a configuration to
but also refreshes (updates the display of) the data that is currently in the data
The configuration tools do not automatically update the display of data when 
changed in the database unless you click Save or Retrieve.

Solution:

Click Retrieve. 

Problem: 
When I saved an edited record, it disappeared from the display of records

Discussion:

If you edit a record so that one of its fields no longer matches the filter selec
in the Select filter data box, and then save that record, it will disappear from the 
list of displayed records. This happens because the save function not only save
the data in the database but also refreshes the open window to display the cu
database data according to the current filter selections.
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Solution:

To see the updated record, select the appropriate filters, and click Retrieve.

Configuration Manager Tools
Use the menu bar in the Configuration Manager window to select the task or
you want.

Table 3-1 Tools Summary

Tool Description

Bulk Configuration Tools Enable you to configure multiple records at a time.

Explorer and List Tools Enable you to both view records and their related 
records and to define, edit, and delete them and the
relationships. 

The difference between the explorer tools and the 
list tools is that the explorer tools manage records 
that have more than one relationship while the list 
tools manage records that have no or only one 
relationship to other records.

Miscellaneous Tools Help you perform configuration tasks for which the 
previous tools are not appropriate.

Wizards Guide you through configuration tasks.

Outbound Option Adds outbound dialing functionality to the existing 
inbound capabilities of ICM software.
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Bulk Configuration Tools
Use the Configuration Manager’s bulk configuration tools to configure multip
records at a time. For how to use these tools, see Chapter 4, “Configuring Multiple 
Records at a Time.”

The bulk configuration tools enable you to bulk configure the following individu
database table records. The tools are named for the records they manage:

• Agents

• Call types

• Dialed number plans

• Dialed numbers

• Device targets

• Labels

• Network trunk groups

• Network VRU scripts

• Peripheral targets

• Regions

• Region prefixes

• Routes

• Trunks

• Trunk groups

• Scheduled targets

• Services

• Skill groups

• VRU port maps
3-8
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Explorer and List Tools
Use the Configuration Manager explorer and list tools to configure and mana
individual database records. 

Explorer Tools

Use the explorer tools to configure and manage database records that have
hierarchical relationships to other records. In this way, at one time, you can 
and update both the individual records and their relationships. You can config
and manage the following records with the explorer tools. The tools are name
the type of records they manage:

• Agent Explorer

• Announcement Explorer

• Database Lookup Explorer

• Device Target Explorer

• ICM Instance Explorer

• Network VRU Explorer

• Network Trunk Group Explorer

• NIC Explorer

• PG Explorer

• Region Explorer

• Scheduled Target Explorer

• Service Explorer

• Service Array Explorer

• Skill Group Explorer

• Translation Route Explorer
3-9
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List Tools

Use the list tools to configure and manage database records that have limite
no hierarchical relationship to other records. You can configure and manage th
following individual records with the list tools. The tools are named for the ty
of records they manage:

• Agent Desk Settings List

• Agent Team List

• Application Gateway List

• Bucket Intervals List

• Business Entity List

• Call Type List

• Dialed Number/Script Selector List

• Enterprise Route List

• Enterprise Service List

• Enterprise Skill Group List

• Expanded Call Variable List

• Feature Control Set List

• Label List

• Media Class List

• Media Routing Domain List

• Network VRU Script List

• Person List

• Reason Code List

• Service Level Threshold List

• Supervisor List

• User List

• User Group List

• User Variable List

• VRU Currency List
3-10
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• VRU Defaults List

• VRU Locale List

Miscellaneous Tools
The following Configuration Manager tools enable you to do miscellaneous 
functions not available with the other tools:

• Deleted Objects

Enables you to view all records deleted from the database and to permanent
delete them if you no longer want them available for your records.

• Integrity Check

Allows you to perform specific integrity checks on the configuration data
the ICM database.

• Region Editor

Allows you to:

– View, create, update (cut, copy, paste, move, or edit), and delete custom
regions.

– View, copy, or move predefined regions, but not edit or delete them.

• Script Reference

Allows you to generate a report that shows which routing scripts reference a 
specific configuration record. 

• System Information

Allows you to view and set general and application gateway information 
about your enterprise.

• Unreferenced

Lists the database tables that have unreferenced records. Use this tool to find
specific integrity problems within the database. 
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Wizards
Two wizards guide you through the configuration of: 

• Translation routes (Translation Route Wizard)

• Call center applications (Application Wizard)

Use these wizards for step-by-step guidance in configuring the above.

Common Bulk, List, and Explorer Tool Features
The bulk, list and explorer tools have the following common features: 

• Common Filter Access

To access data from the database, in the Select filter data box of the explorer, 
list, or bulk insert tool window, select the type of data you want and click 
Retrieve button.

• Record Status Symbols

When you make an edit, the record’s status symbol updates accordingly. This
appears to the left of the record name in the list box of the explorer or list 
and in the State column of the bulk tool. 

Table 3-2 Record Status Symbol Descriptions 

Symbol Description

A green check mark means the object has not change
since you retrieved it from the database or made a sav

Note This feature not common to the explorer tools.

A red X means the object is marked for deletion and wil
be deleted when you click the Save button.

A yellow arrow means that the object's data has been 
changed and the changes have not yet been saved in 
database.
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• ID status box

The label in the ID box at the bottom of the screen identifies the ICM system 
(instance) on which you are working.

• Delete/Undelete button

When a record is selected and you click the Delete button, that button toggles
to Undelete and a red x marks the record for deletion. As soon as you save 
your database changes the marked record(s) is deleted from the database.

• Save button

No changes are made to the database until you click the Save button.

A yellow addition sign means the object is to be inserted
into the database when you click the Save button.

A red circle with a red slash through it indicates the 
object was created using an application and is controlle
by the Application Object Filter (AOF).

Table 3-2 Record Status Symbol Descriptions  (continued)

Symbol Description
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Common List and Explorer Tool Features
The list and explorer tools share the following features. 

• List Box of Retrieved Records

Both the explorer and list tools have a list box that displays retrieved reco
Selecting a record in this list displays that record’s properties in the right s
of the tool window. Once displayed, you can edit a record if you have 
maintenance access to it. 

– Tree (only in explorer tools)

In an explorer window, the retrieved list is called a directory tree, which 
can be expanded or contracted to show a hierarchy of records. A legend 
above the tree identifies the types of records that can be displayed in th
tree. 

With the mouse, you can select a record in a tree and then move it to 
another part of the tree, as long as it’s object type belongs in that tre
location.

– UNASSIGNED (only in explorer tools)

The explorer tree can also contain UNASSIGNED records. These are 
stored in an UNASSIGNED directory for the selected directory tree 
object. 

A record is named UNASSIGNED if it was not assigned (mapped) to
parent object. For example, a label, created in the Bulk Configuratio
Tool, might not have been assigned to a peripheral target, or a route m
not have been assigned to a service.

You can also use the Label Bulk Configuration tool to take the output
a switch and create 20 or 30 labels. Then, using an explorer tool, you can
attach the labels to an appropriate location.

– List  (only in list tools)

In a list window, the retrieved list is called a list and has no legend above
it since its records have no or only one relationship to another record

• Adding New Records

The Add button is enabled only after you use the Select filter data section o
the window.
3-14
Cisco ICM Enterprise Editon Configuration Guide Version 6.0

78-11589-03



Chapter 3      The ICM Configuration Manager
Configuration Manager Tools

er 
hy. 
rds 

o 

d. 
In the explorer tools, when a record in the tree is selected, you can add anoth
record of the same kind or a record immediately below it in the tree hierarc
In the list tools, the add button is enabled only for the single type of reco
listed.

• Deleting Records

Selecting a record and clicking Delete marks the record (with a red x) for 
deletion. However, the record is not deleted until you click Save. 

Delete toggles to Undelete when you select an object marked for deletion. T
undelete an object marked for deletion, select it and click Undelete.

• Options Menu

In the explorer and list tool windows, right clicking on a retrieved record 
displays an options menu containing all the editing options for that recor

Note This menu is not available in the list tools if you have read-only 
access.
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Accessing Database Records
The bulk configuration, explorer, and list tools enable you to access records from
the database in the same way. In these tools, use the Select filter data box to select 
and retrieve data from the database. Until you retrieve database data, no data is
displayed. 

In the top left of the bulk configuration insert, the explorer, and the list tool 
windows is a Select filter data box similar to the following.

Figure 3-3 Select Filter Data

In this example, all records belonging to the Boston_PG_1 peripheral and havin
JO in their names are selected for retrieval from the database. 

The filters used to select data vary according to the type of data. In the preceding
example, data is first selected by peripheral and then by name. Some filter 
selection boxes have only optional filters.

If any editable field is changed, an additional dialog appears (below the Select 
filter data dialog) displaying the original filter settings. In addition, the tree lis
box and all buttons except Retrieve, Close, and Help are disabled. 

Clicking Close cancels the filter changes and returns the fields to their original 
settings. Clicking Retrieve closes the Select filter data dialog and enables the 
display (in the tree list box) of the record retrieved based on the selected filt
criteria.

Table 3-3 describes how the optional filters, the check box, and the filter butto
work for all the bulk insert, explorer, and list tools.
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Table 3-3 Common Filter Functions  

Filter Item Function

Optional 
Filter

None in the optional filter box means no optional filtering. All 
data is displayed for the selected records.

The optional fields to filter on differ by record type according 
to both the fields in a record and the fields considered useful as 
filters.

Condition If the selected
Optional Filter 
is

Then

None The Condition filter is ignored.

A text filter
(for example, 
Description)

Select one of the text conditions (Contains, 
Ends With, Starts With, Is Blank) and enter 
an appropriate entry in the Value field.

A numeric filter 
(for example, 
Trunk Number)

Select one of the numeric conditions (Equal,
Greater Than, Less Than, Not Equal) and 
enter an appropriate entry in the Value field.

The available numeric conditions can 
change depending on the record data. For 
example Equal or Not Equal might be the 
only choices.

Value The entry in this field is based on the selections made in the 
Optional Filter and Condition fields. If None is selected in the 
Optional Filter field, this field is ignored.

Save
check box

Checked, indicates the current settings are saved so that whe
you next open the list tool for this type of record, the current 
settings will be selected. However, no data is displayed until 
you click the Retrieve button.

Retrieve
button

This button displays the data selected in the Select filter data
box.

Cancel filter 
changes
button

If you change the Optional Filter settings after a Retrieve, 
clicking this button resets the filter settings back to the 
preceding ones.
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Saving Configuration Data to the Database
When you have completed adding information in an open configuration wind
click Save. 

ICM software saves the configuration data and immediately applies your chan
to both the local and central ICM database. 

Note Whenever any data is retrieved by a configuration tool, it notes the last chan
mark on that data at this point in time. If you then attempt to change that item
first checks the current copy in the database for its change mark. If the chan
marks do not agree, it indicates another user has changed this item since yo
retrieved it, and an error is returned. You must then discard any changes, using
Retrieve to obtain the latest information for editing.

This approach is called optimistic locking, and assumes that it is rare to have tw
people needing to change the same item at the same time. This prevents th
performance and maintenance issues involved with hard locking items, while
preventing one person from accidentally overwriting another user’s changes

Feature Control
In general, feature control addresses the need of restricting users, or classes of 
users, from all functionality of the ICM software.

A distinction should be made between object level control and feature contro

• Object control, part of the ICM software partitioning feature, is a method
security for prohibiting access to configuration data in the ICM database

• Feature control, like the limited AW, is a method of security for prohibitin
access to ICM software features.

Script Editor feature control addresses the need of restricting users, or classes o
users, from some or all of the functionality of the ICM Script Editor software.
a possible deployment scenario, an ICM software administrator can restrict 
certain people from doing specific types of script editing. Similar functionality 
was previously available in the ICM software in both the “Limited AWs” and th
WebView “Quick Edit” feature control.
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An administrator has two means to restrict access to the editing features of Script
Editor and Internet Script Editor:

• Edit options 

• Script node control 

It is also possible for an administrator top use a combination of both feature 
control options.

Note In previous ICM Software versions (including, and prior to ICM 4.x), any chan
made to the read-only status of a user was not dynamically updated in the Scrip
Editor. Script Editor had to be closed, then reopened before the change took
effect. 
In ICM Software version 5.0, any change made to a user’s read-only status (us
the User List tool) is automatically updated in Script Editor.

Refer to the Cisco ICM Software Scripting and Media Routing Guide for 
additional feature control information.

Script Node Control

Script node control allows an administrator to create feature sets that can be 
assigned to users. The feature set controls which script nodes are accessible to th
user. 

Node Control Table

The node control table (on the Configuration Manager Script Editor Feature 
Control dialog) has two columns, the Node column and the Available column. 
This table allows an administrator to create feature control sets that can be 
assigned to users. The feature control set controls which script nodes are 
accessible to the user.

If a script is opened that contains a disabled node, you can browse or monito
script but you cannot put the script into edit mode. If you attempt to put this sc
into edit mode a message indicating you are not authorized to enter edit mo
displayed. However, you can still Quick Edit the script, just not the node.
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Node column

A node is an executable element within a script. A script consists of nodes, 
connections, routing targets, and comments. Every script begins with a Start node
This column lists of all the nodes that can be used in a script.

Available column

Each checked node in this column appears on editing pallet of the 
feature-control-set user, regardless of the edit mode (Full Edit or Quick Edit 
Only).

There are two possible presentation effects:

• Enabled nodes are displayed on the object palette

• Disabled nodes are removed from the object palette

Configuring a Feature Control Set

Configuring a feature control set consists of:

• Creating a feature controls set (see How to create a feature control set, 
page 3-20)

• Assigning users to a feature controls set (see How to assign users to a feature
control set, page 3-21)

• Selecting the script nodes available in a feature controls set (see How to select 
script nodes for a feature control set, page 3-21)

How to create a feature control set

The system administrator can create a feature control set using the ICM 
Configuration Manager on the ICM distributor.

Step 1 Ensure the user(s) the feature set is to be assigned to are configured.

Step 2 Start the Configuration Manager by selecting:
Start > Programs > ICM Admin Work station > Configuration Manager
The Configuration Manager dialog opens.

Step 3 Select Tools > List Tools > Feature Control Set List.

Step 4 In the Feature Control Set section (on the left), click Add.
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Step 5 Select the Attributes  tab.

Step 6 Enter the name of the feature control set. The name appears in the left section 
when Enter or Tab is pressed.

Step 7 Enter a description (optional).

How to assign users to a feature control set

Step 1 Start the Configuration Manager by selecting:
Start > Programs > ICM Admin Work station > Configuration Manager
The Configuration Manager dialog opens.

Step 2 Select Tools > List Tools > User List.

Step 3 Select the user to whom feature control set is to be assigned.

Note If no users appear, add the user(s) using the User List Tool.

Step 4 On the Attribute tab, select the feature set for the selected user. 

Step 5 Click Save when you are finished assigning feature sets.

How to select script nodes for a feature control set

Step 1 Select the name of the feature control set to be assigned.

Step 2 Select the Attributes  tab.

Step 3 Select Advanced (under Script Editor).

Step 4 In the Script Editor Feature Control dialog, select the nodes for this feature 
control set and an edit option (Full Edit or Quick Edit).

Step 5 Click OK.

Step 6 Click Save.
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Security Settings
For the Security button (in the explorer and bulk tools) or tab (in the list tools
be visible and enabled:

• The ICM Partition installation setup option must be installed on your ICM 
system.

• You must have maintenance access to the selected database record(s) and t
the system class.

Note For additional information refer to the ICM Software Security Guide.

How to view or apply security settings 

Step 1 Follow the steps for viewing the item whose security setting you want to see
apply. (See the online help if you have questions.)

The selected item’s configuration information displays.

Step 2 Select the item(s) whose security settings you want to view or edit. 

Note You can apply security setting to more than one record at a time only in 
the Bulk Configuration tool. In this tool’s window, if there are security
settings on the selected records and they are mixed (different record
having different settings), no security data is displayed. If you want to
apply one setting to records with mixed settings, select Override existing 
settings. 

Step 3 Click Security. The Security dialog box displays. 

Step 4 View and/or make the security settings.

• To remove access to the records: In the User Access display area of the 
Security dialog box, select the user or group to remove and click Remove. 

• To edit access to the records: In the User Access display area, select the use
or group to edit and click Edit  or double-click on the item you want to edit.
Then in the Edit Permissions dialog box, select the access type and click 
OK.
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• To add access to the selected records: 

a. Click Add. The Add Users and Groups dialog box displays. 

b. Select User or Group. 

c. Select the user or group name(s) for which you want access rights. 

d. Select the Access type from the selection list and click OK:

Read access means a specific user or group can view or reference the 
object, but cannot modify it.

Reference access means a specific user or group can reference the objec
in a script. This includes read access, but not write access.

Maintenance access means a specific user or group can update or de
the object as well as view and use it.

Step 5 When done, in the Security dialog box, click OK.

Validating Configuration Data
After making changes or additions to your configuration, you should always 
check that it is internally consistent and complete. 

Note It is especially important to perform integrity checks if you have imported data 
from another source.

How to check the integrity of your configuration data 

Step 1 In the Configuration Manager menu, select Miscellaneous Tools > Integrity 
Check. The Integrity Check dialog box appears.

Step 2 Choose the type of check option that you want to perform or click Select All to 
choose all the check options. (For specific information about each of these option
and the tables and fields they check, see the Configuration Manager online help
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Step 3 Click Perform Check. The Configuration Manager performs the check and on
of the following happens:

• If the check discovers a problem, the Configuration Manager displays 
messages in the Integrity Problems text box. Double-click on a message
receive specific information about the records in the data table at the bottom
of the window.

• If the check completes without finding any invalid data, the Configuration
Manager displays a message saying the integrity check completed 
successfully.

Step 4 When all checks are complete, click Close. The Integrity Check dialog box closes

Many database records need references to related records. For example, each 
peripheral target ought to reference a route and each trunk group ought to 
reference a network trunk group.

How to check record references 

Step 1 In the Configuration Manager menu, select Miscellaneous Tools > Unreferenced 
Objects. The Unreferenced Object dialog box appears listing the database table
containing objects that are missing references.

Step 2 To see the specific rows that are missing references in a table, double-click on the
table name. Double-clicking on a table name entry displays that table showing
records that are missing references. 

Deleting Configuration Records
At some point, you might want to remove configuration records from your 
database; for example, if data has been entered in error or changes occur in your 
business.
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How to delete a record 

Step 1 Within Configuration Manager, open any one of the tools in which you can 
configure that type of record and retrieve the record. 

Step 2 Select the retrieved record. 

Step 3 Click Delete. A red X (marked for deletion) appears in the window next to the
name of the record. The Delete button toggles to Undelete. To undelete the record
select it and click Undelete.

Step 4 Click Save to save the deletion to the database. The record is deleted from th
database and is removed from the window.

Note Some deleted records can still be viewed, as described in the 
“Administering Deleted Records” section on page 3-27. The following 
section, Types of Deletion, describes why.

Step 5 Click Save. The deletion is saved to the database and the record disappears from
the window.

Types of Deletion

Depending on the record involved, the Configuration Manager performs one
two types of deletion:

• Immediate deletion. The ICM software immediately removes the record 
from the database. (Also known as “physical deletion.”)

• Logical deletion. The ICM software sets the record’s Deleted field to Y (yes), 
but the record remains in the database. The Configuration Manager and the
ICM Router treat the record as though it were deleted. The record remain
the database, however, for historical reporting purposes.
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Immediate Deletion

Some tables—for example, the Skill Group Member table, which maps agents to
skill groups—do not have a Deleted field. When you delete a record from su
table, ICM software immediately removes the record from the central and lo
database.

Logical Deletion

Other tables, for example, the Skill Group table, which describes a skill grou
associated with a peripheral—do have a Deleted field. When you delete a record
from such a table, ICM software does not remove the record from the central and
local database. Instead, ICM software sets the record’s Deleted Field to Y to 
indicate that it is logically deleted. 

Logical deletion ensures that any references to the record—for example, 
references to a skill group in call detail records—remain valid. However, the
Configuration Manager and the Script Editor treat the record as though it we
deleted.

Caution Never attempt to set a configuration record’s Deleted field directly. Changing
Deleted field directly can compromise the integrity of your ICM database. Use
Configuration Manager Tools > Miscellaneous Tools > Deleted Objects option 
to permanently remove logically deleted records. 

Deletion Dependencies

How a configuration tool processes a record deletion request depends on whethe
and how, the record is referenced by other configuration records:

• If no other records reference the current record, the configuration tool deletes
the record.

• If other records reference the current record—and the configuration tool 
neither modify the references nor delete the other records—the configuratio
tool does not delete the record.
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Administering Deleted Records

The Configuration Manager lets you view logically deleted records. It also allows
you to permanently delete these records.

How to view deleted records 

Step 1 In Configuration Manager menu, select Tools > Miscellaneous Tools > Deleted 
Objects. The Deleted Objects dialog box appears, indicating the tables in which
records are marked for deletion and the number of records so marked.

Step 2 To see the specific records marked for deletion within a table, double-click o
table name. If you double-click on a table name entry, a list window appears 
showing records from that table that are marked for logical deletion.

Step 3 To remove a record(s) from the database entirely, select it in the list (or use 
Select All button to select all) and click Delete Permanently. The Configuration 
Manager displays a message indicating the operation completed.

You must have access rights to a record to be able to delete it permanently.

Step 4 Click Close to close the dialog box.
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Configuring Multiple Records at a 
Time

This chapter shows you how to use the Configuration Manager Bulk 
Configuration Tool to insert and update multiple configuration records in a sin
transaction from a single screen. 

In some cases, you might need to work with multiple records of configuration d
simultaneously. For example, you might want to: 

• Import records from a text file

• Modify a specific field in multiple records

• Insert a set of records 

The Bulk Configuration Tool let you perform these operations on several ICM
data tables simultaneously. This tool supplements the Configuration Manage
explorer and list tools, which allow you to insert and update single records.

How to access the Bulk Configuration Tools 

Step 1 Double-click the Configuration Manager in the ICM Admin Workstation group.

Step 2 In the Menu selection box, select Tools > Bulk Configuration .

Step 3 Then from the submenu selection list, select Insert if you need to insert data or 
Edit  if you need to edit.

Step 4 Finally, in the next menu selection list, select the type of table with which yo
need to work.
4-1
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Data You Can Bulk Configure
From the Bulk Configuration menu, you can choose to create or update recor
one of the following database tables: 

• Agent

• Call Type 

• Dial Number Plan

• Device Target

• Dialed Number 

• Label 

• Network Trunk Group

• Network VRU Script 

• Peripheral Target

• Region

• Region Prefix

• Route

• Scheduled Target 

• Service

• Skill Group

• Trunk

• Trunk Group

• VRU Port Map 

Start by selecting the Bulk Configuration Insert or Edit menu. Then select th
database table you want to modify. 

If you have any questions, see the online help. The help contains table record
field definitions and procedures for all that you can do with the Bulk 
Configuration Tool. The following sections briefly describe the tool and how 
use it.
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Insert and Edit Windows
Depending on whether you select Bulk Configuration  > Insert or Edit , the Bulk 
Configuration Insert or Edit window for the selected database table opens. The
two windows have the following features: 

• Same Options

Both windows have the same options except for Insert (Insert window) a
Retrieve (Edit window). 

Reason for Two Windows

The reason for having both an insert and an edit window is to prevent 
confusion when editing records since some configuration objects can onl
edited when inserted into the database, the database being a relational 
For example, when you insert the record of a label, you can edit all its fie
However, once you define (and save it in the database) its routing client, the
only way you can redefine the routing client is by deleting the label and 
creating a new one.

• Saving Changes

The changes you make in the Insert or Edit window are not applied to the 
database until you click Save or Close. The Close button closes the window
and gives you the option of saving or cancelling any database changes.

• Initial Display

Initially, both windows open without data and wait for your retrieval 
command (in the Edit window) or insert/import command (in the Insert 
window).

• Editable Data Table Fields

Columns with an asterisk (*) next to the title indicate required fields. Fiel
shaded in blue cannot be modified directly. However, in some cases settin
or changing one field will make another field updateable.
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• Record State

The first data column contains a symbol indicating the condition of a row
record.

Bulk Configuration Features
You can do the following with the Bulk Configuration Tool:

• Retrieve records from the database (Edit Window only).

• Sort records by a single column or by multiple columns.

• Use the search tool to find data in a list of records. 

• Apply a single value to a range of fields or apply a range of values to a ra
of fields.

• Insert additional new rows (records) into the database table (Insert Window
only).

• Import multiple record data (either whole records or record fields).

• Export multiple record data (either whole records or record fields).

• Set or change security settings to multiple records at a time.

• Delete records. After deletions are saved to the database (or after you c
your editing session), you can no longer undelete deleted records.

• Undelete records that are marked for deletion in the current editing sess

Symbol Indicates the record is

Not changed since you retrieved the record or saved it.

Changed in the current editing session but not yet saved.

To be inserted into the database when you save your edits

 To be deleted from the database when you save your edits
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The following sections describe how to use the Bulk Configuration Tool.

Retrieving and Editing Records
Use the Select filter data box in the Edit window to retrieve records from the 
database. 

How to retrieve and edit existing records 

Step 1 Within the Bulk Configuration > Edit menu, select the name of the database 
table you want to modify. The appropriate Edit window appears. (Initially, no 
records are shown.)

Step 2 Do one of the following:

• To retrieve a range of records, specify values in the Select filter data fields. 
For example, you could enter values that would retrieve only dialed numb
associated with a specific customer, with a specific routing client, or both.

• To retrieve all records, leave the Customer and Routing Client fields set to 
All .

Step 3 Click Retrieve. The appropriate rows are displayed in the Edit window as in t
following example.
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Figure 4-1 Example Bulk Configuration Edit Window

Step 4 Once you have retrieved the records you want to edit, you can edit individua
records or a range of records. In a range of records, you can enter a range of value
or the same value. You can also delete, import, export, and sort records. 
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Sorting Records
You can sort records (rows) in two ways: by one column or by multiple colum

You might want to sort by multiple columns if the first column(s) to sort by ha
the same value in more than one field, for example, the same routing client, la
or customer name. 

• To sort records by one column: double-click on that column’s header. To 
reverse the sort, double-click a second time. When you double-click, an 
(Ascending) or D (Descending) appears after the header to indicate the 
order.

• To sort records by multiple columns, see the following procedure.

How to sort records by multiple columns 

Step 1 In the Insert or Edit window, click Sort. The Sort dialog box displays.

Step 2 In the Columns available for sort list, select each column by which you want to
sort and click Add.

The primary sorting column will be the first column listed in the Columns selec
for sort list. To change the column sort order, select a column and click the U
Down arrow.

The data within each column is sorted in Ascending order unless you deselect th
check box beside the column.

Step 3 Click OK.

Finding Data in a List of Records
After you have retrieved a set of records, you can use the Find area of the Edit 
window (Column Name and Expression fields) to search for specific records 
within the set. 
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How to find data 

Step 1 In Find box of the Edit or Insert window, select the database column in which yo
want to search for data. 

Tip : You can also select a column by clicking in that column. 

Step 2 In the Find box Expression field, enter the value for which you want to search. Yo
can enter a full value or a sub-string.

Step 3 Click Find Next to locate the first record that matches the search criteria. The f
row that contains the specified expression in the selected column is highlighted

Selecting Data
You can select whole records for importing, exporting, setting security, deleti
or undeleting. Or, you can select the same field in multiple records for 
simultaneous editing.

How to select records 

Clicking in the left-most numbered field in a row both selects that row and 
highlights it. Clicking in any field in a row also selects the row but does not 
highlight it. 

How to select one field in multiple records 

You can select one edit-control field (when there is no section box in the field) in
multiple records in any one of the following three ways:

• Click the field where you want to start and, keeping the left mouse button held
down, move the cursor to the last field.

• Click the field where you want to start. While holding down the Shift key, 
click the last field.

• Click the field where you want to start. While holding down the Shift key, 
make your selection by clicking the down arrow.

• Press Ctrl , then left-click on each field you wish to select. This allows you to
select a random group of fields.
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For selecting one value in multiple selection box fields, see the following section,
“Editing a Range of Data”.

Editing a Range of Data
You can edit a range of data in a table column in several ways:

• Apply a single value to a range of (edit-control) fields

• Apply a single value to a range of selection-box fields

• Apply a range of values to a range of fields

How to apply a single value to a range of edit-control fields 

An edit-control field is one you can edit that does not contain a selection box

Step 1 Make your selection: click the field where you want the range to start and, kee
the left mouse button held down, move the cursor to the last field in the range.

Step 2 Type the new entry that you want to appear in all the fields.

Step 3 Click Enter or Tab. This applies the change to all the records in the range and 
moves the focus to the next data field.

How to apply a single value to a range of selection-box fields 

Step 1 Select the first field where you want the range to start.

Step 2 Hold down the Shift key and keep it down for steps 3, 4, and 5. 

Step 3 Click the selection-box down arrow but keep the left mouse button held down an
select the fields you want in the range.

Step 4 Click the last field in the selection to display the selection list. 

You can also open the selection box by pressing Alt  + an arrow key.

Step 5 Click your selection.
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Step 6 Click Enter or Tab (or in any other field). This applies the change to all the 
records and moves the focus to the next data field.

How to apply a range of values to a range of fields in a column 

Step 1 Select the range of fields in a database column. This enables the Edit Rang
button. 

Note The Edit Range button does not work for selection-box fields.

Step 2 Click Edit Range. The Edit Range dialog box displays.

Step 3 In the Edit Range From field, enter the first number of the range.

Step 4 In the Prefix and Suffix fields, you can optionally enter substrings to appear at
start and/or end of each value. The Edit Range dialog box lists the generate
values.
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Note When entering a numeric range, you may also enter leading zeros to 
ensure proper alignment (i.e., 001 to 999).

Step 5 Click OK. This applies the changes to the fields you selected in the Insert or Edit 
window.

Inserting New Records
You can insert new records by inserting multiple blank rows (records) and fill
in the data (see How to insert new records, page 4-11) or by importing the data 
(see How to import data, page 4-12). 

You can also edit the data you insert when you insert it.

How to insert new records 

Step 1 In the Bulk Configuration > Insert menu, select the name of the data table to
which you want to add records. The appropriate Insert window opens, 
automatically displaying one new row.

Step 2 To create additional rows, enter the number of additional rows in the Quantity 
field and click Insert. The additional rows are added in the Insert window. 

Step 3 Enter the data in the rows: 

• If you want to edit individual fields in the new rows, type the information yo
want in each of the fields and go to Step 8.

• If you want to edit a column in multiple rows so that a range of values is
entered, go to Step 4. 

• For other ways of entering data into multiple rows, see the “Editing a Range 
of Data” section on page 4-9.

Step 4 Select the rows in the column you want to modify. 

Step 5 Click Edit Range. The Edit Range dialog box appears.

Step 6 Enter a prefix (optional), the start value for the range, and a suffix (optional). 
generated values are listed in the dialog box.
4-11
Cisco ICM Enterprise Editon Configuration Guide Version 6.0

78-11589-03



Chapter 4      Configuring Multiple Records at a Time
Bulk Configuration Features

mn 

e 
ss, 

ort 

ey 

 
alue 
Step 7 Click OK to close the Edit Range dialog box and apply the values to the colu
you selected.

Step 8 When you have finished setting fields in the new rows, press Enter to apply your 
changes to the ICM database.

You can leave empty rows, the system ignores them.

Note No changes are made to the database until you press Enter.

Importing Data
You can import data from a specified text file into the opened database table. 
Whole records or only columns of data can be imported, if the data matches (se
Step 3 of the following procedure). If any error occurs during the import proce
the process is cancelled.

How to import data 

Step 1 In the Insert or Edit window, click Import .

Step 2 In the Import dialog box, click File.

Step 3 In the File Open dialog box, select the file containing the data you want to imp
and click Open. For a description of the required import-file format, see the 
“Import/Export Data File Format” section following this procedure.

The Import File Data area displays the first few lines of the opened file. 

• When importing data in the Edit mode, the following rules apply:

– The Bulk Configuration Tool reads only those records whose primary k
values match those of records in the Edit window.

If there is a record that does not match the primary key value, the record
is considered to be an error and a message box with the primary key v
pops up to ask you to correct the problem.
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– If any field in the import record is null, the corresponding field value 
the grid window become blank for an edit cell or uses the default val
for a drop-down list cell.

– If any field is missing in the import file, the corresponding field in the
Edit window remain unchanged.

– If there is a larger number of records in the file to be imported than t
number of rows in the grid, it is considered as an error and a message
pops up asking you to correct it.

– If there is a duplicated primary key in the file to be imported, it is 
considered as an error. A message box with the duplicated primary key 
value pops up asking you to correct it.

– After importing, all records imported (including records marked for 
deletion in the grid) are marked as “Changed” regardless whether the 
value is changed or not.

– After a importing, the records are displayed in index order (ordered by 
logical keys). If you did not sort before importing, the order appears 
same after the import.

• When importing data in the Insert mode, the following rules apply:

– Only a single import is supported and any existing rows are removed
from the grid. When you click Import , a message box pops up if there i
any record in the grid. You will see the following message:

“All the existing data will be replaced by the data to be imported. If yo
want to retain the current data on the grid please click the Cancel bu
then save or export the existing data. Click the OK button to proceed w
the importing.”

– After importing, all rows are marked as “New” and the ordering is the
same as that in the file imported from.

– In the Import Insert mode, the tool reads only those records whose 
primary key values are not presented. If the primary key field is selec
for file to be imported, it is considered an error and a message box wit
the primary key field name pops up asking you to correct the problem

– If any field in the import record is null, the corresponding field value 
the grid window becomes blank for an edit cell or uses the default value
for a drop-down list cell. 
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Note If headers are included in the imported file, the Add and Remove butt
are not enabled and you can only import the record(s) as a whole. In 
case, go to Step 6. 

Step 4 If the imported data does not contain headers, in the Available Fields list box, 
select the names of the fields to import that match the data and click Add.

Step 5 To change the order of the columns, select a column and move it within the list b
clicking Up or Down.

Step 6 Click OK. The data is imported into the data table.

Import/Export Data File Format
The import and export files used by the Bulk Configuration Tool can optional
include a header that identifies the table and columns in the file. The header is 
followed by one line for each row of data.

The following rules apply to the file headers:

• A line beginning with a number sign (#) is a comment and is ignored.

• Blank lines are also ignored.

• The header content is indicated by a line beginning with two underline 
characters and the word TABLE or COLUMNS. The following line contain
the name of the table or the name of the columns. For example:

__TABLE
Call_Type
__COLUMNS
CallTypeIDEnterpriseNameDescriptionDeleted CustomerDefinitionID

• All column names must be on a single line and are separated by Tab 
characters.

The following rules apply to the data in the files:

• One row of table data per line.

• Column values must be in the same order in all rows. If columns are specified
in the header, the columns in the data rows must be in the same order.
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• Column values are separated by a single Tab character.

• Fields intentionally left blank must be represented by two adjacent Tab 
characters or a Tab character at the end of a line. On import, the default value
is used for such a value.

• String values may include spaces.

• An error occurs on import if a line contains too few or too many values.

Tip : A simple way to create the import file with a valid format is to use Excel a
save it as Text (Tab delimited) (*.TXT).

Exporting Data
The export function saves the selected records or field(s) to a tab-delimited 
file that you can import into the ICM database or into a database tool such a
Microsoft Excel. If any error occurs during the export process, the process is
cancelled.

How to export data 

Step 1 Select the rows with fields you want to export. 

Note If you intend to import this data into the Edit window, you must export
primary key field along with any other fields. The primary key field ha
the same column name as the database table name.

Note All rows selected (including records marked for deletion) are exported.

Step 2 Click Export . 

Step 3 Select the Header option if you want to include a header containing the table nam
and column names in the output file. This is recommended since it makes it c
what is in the file. 

Step 4 In the Export dialog box, select the column(s) you want to export and click Add 
or AddAll.
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Step 5 To change the order of the columns to export, select one of them and move 
within the list by clicking Up or Down.

Step 6 Click File and specify the file name and directory to which to save the data.

Step 7 Click OK.

Applying Security Settings to Multiple Records
For instructions on how to view or apply security settings to multiple records, 
Security Settings, page 3-22.

Deleting and Undeleting Records
You can delete one or more records at a time and you can undelete records marke
for deletion.

How to delete records 

Step 1 Select the row(s) to be deleted.

Note Selecting any field in a row (or any range of fields in a column) selec
the rows of which they are a part.

Step 2 Click Delete. The selected rows are marked for deletion.

Step 3 Click Save. The rows marked for deletion are deleted from the database. 

Note You can no longer undelete records marked for deletion once you ha
saved your changes to the database.
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How to undelete records 

Step 1 Select the rows marked for deletion. 

Step 2 Click Undelete. The deletion mark is removed from the records.

Step 3 Click Save. The change is saved to the database.
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Configuring Routing Clients 

This chapter describes how to set up routing clients and their directly related
elements. It includes:

• An introduction to the Routing Client subsystem

• Instructions on how to view, delete, modify, and define:

• Network Interface Controllers (NICs) 

• Routing clients 

• Dialed numbers

The Routing Client Subsystem
A routing client is an entity that sends route requests to ICM software. A rout
client can be:

• A public network interexchange carrier (IXC), such as AT&T, BT, MCI, 
Nortel, or Sprint 

• A private network peripheral, such as an Aspect or Lucent ACD

Figure 5-1 shows the elements of the Routing Client subsystem.
5-1
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Figure 5-1 Routing Client Subsystem

Interface Controllers
Each routing client must be associated with an interface controller. An interface
controller operates on two levels: physical and logical. A physical device is a 
single instance of a device. A logical device is either a single physical device o
more than one physical device running duplexed. 

A Physical Interface Controller can be a:

• Network Interface Controller (NIC). A NIC communicates directly with the 
IXC’s signaling network, reading call routing requests from the network a
transferring them to the ICM’s Central Controller. This chapter describes how
to set up a NIC.

Logical Interface
Controller

Physical Interface
Controller

Routing Client

Dialed Number

Peripheral

36
43

8
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• Peripheral Gateway (PG). A PG communicates with the ACD, PBX, or VRU
at a contact center, monitoring status information from the peripheral an
sending it to the ICM’s Central Controller. The PG can also act as a rout
client, sending routing requests to ICM software. For information on sett
up Peripheral Gateways, see Chapter 6, “Configuring Peripherals and Trunk
Groups.”

Examples of Routing Client Subsystems 
You can associate more than one routing client with a single logical interface 
controller. For example, if an ICM Network Interface Controller (NIC) is serving 
two AT&T Intelligent Call Processing (ICP) subsystems, as shown in Figure 5-2, 
you can define each as a separate routing client through the single logical 
interface controller. 

Figure 5-2 Two Clients / One Logical Interface Controller

On the other hand, if you have two ACDs performing private network routing
through two different Peripheral Gateways, as shown in Figure 5-3, you must 
define each as a routing client because each Peripheral Gateway is a separ
logical interface controller. 

Network Interface
Controller (NIC)

Routing Client #2:
      AT&T ICP #2

Routing requests
(and responses)

Routing Client #1:
      AT&T ICP #1

IXC Switch
#1

IXC Switch
#2

36
43

4
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Figure 5-3 Two Clients / Two Logical Interface Controllers

Configuring a Network Interface Controller (NIC) 
Use the NIC Explorer to view, define, modify, or delete Network Interface 
Controller information and its associated routing client information. 

The NIC Explorer generates records that set up a logical interface controller, one
or more physical interface controllers, and one or more routing clients.

How to view a NIC and its routing client(s) 

Step 1 From the Configuration Manager menu, select Tools > Explorer Tools > NIC 
Explorer. 

The NIC Explorer window appears.

Step 2 In the Select filter data box, select the filters you want.

Step 3 Click Retrieve. The name(s) of the retrieved NIC(s) are listed in the tree list b

Peripheral Gateway (PG) #1 Peripheral Gateway (PG) #2

Routing requests
(and responses)

Routing Client #1:
      Lucent ACD #1

Routing Client #2:
      Lucent ACD #2

Two ACDs performing
private network

routing

36
43

5
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Step 4 In the tree list box, select the NIC whose records you want to view. The sele
NIC’s configuration information displays in the fields on the right. For field 
descriptions, see the “NIC Explorer Tab Descriptions” section on page 5-5.

Step 5 To view a routing client record, in the tree list box, expand the tree branch for th
selected NIC and select the NIC’s routing client icon.

The routing client configuration information displays in the window on the righ
For field descriptions, see Table 5-3 on page 5-8.

NIC Explorer Tab Descriptions
The following tables describe the tabbed property fields and buttons that 
configure a NIC and its routing client(s).

Logical Interface Controller Tab

The Logical Interface Controller tab allows you to view (and define or edit, if y
have maintenance access) the properties of the selected logical interface 
controller.

The NIC (Network Interface Controller) is the computer and process within ICM
software that reads call routing requests from the network and transfers them to 
the ICM Central Controller. It consists of a logical interface controller and one or
two physical interface controllers. The number of physical interface controllers 
permitted depends on the client type.

Table 5-1 Logical Interface Controller Tab Descriptions

Field/Button Description

Controller ID 
(required)

A unique identifier for the NIC’s logical controller. This 
is a read-only field. When you create a new NIC, the 
system places UNASSIGNED in this field and 
automatically creates an ID when you save your edits.

Name (required) The enterprise name for the NIC’s logical controller. 
This name also identifies the NIC and must be unique 
for all logical controllers in the enterprise. 
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Physical Interface Controller Tab

The Physical Interface Controller tab allows you to view (and define or edit, if you 
have maintenance access) the properties of the selected NIC’s physical inte
controller(s).

Client Type (required) The type of routing client serviced by the NIC. For 
example, Lucent, MCI, Sprint, and so on. When defining
a new NIC, select one from the pop-up selection box.

Selecting a type of routing client automatically places 
that type’s default values in the Routing Client’s 
Timeout Threshold, Late Threshold, Timeout Limit, Use 
DN/Label Map, and Client Type fields.

Configuration 
Parameter

A string containing information such as logon 
information, specific to the interface controller device. 
For example: -rtuser UserName -rtpswd Password

Description Additional information about the Logical interface 
controller. 

Add Physical Interface 
Controller

Click this button to add one or more Physical Interface
Controllers.

This button is disabled when there is no client type, as
in a new NIC record, or when the NIC node reaches its
upper limit of Physical Interface Controllers.

Table 5-1 Logical Interface Controller Tab Descriptions (continued)

Field/Button Description
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Routing Client Tab

The Routing Client tab allows you to view (and define or edit, if you have 
maintenance access) the properties of the selected routing client. The Routing 
client is the entity that sends routing requests to ICM software. 

Table 5-2 Physical Interface Controller Tab Descriptions

Field/Button Description

Associated 
Physical Interface 
Controllers

A duplexed NIC has two entries in the Physical Interface
Controller table and a single entry in the Logical Interface 
Controller table. 

ID A unique identifier for the NIC’s associated physical 
interface controller. This is a read-only field. When you 
create a new NIC, the system places UNASSIGNED in 
this field and automatically creates an ID when you save
your edits.

Name The enterprise name of the routing client associated with
the NIC. This name must be unique for all physical 
controllers in the enterprise. 

Description Any other information about the physical interface 
controller. 

Modify To edit the name or description of the physical interface 
controller, click this button and in the Physical Interface 
Controller dialog box enter your edits and click OK.

New To enter a record for a new associated physical interface
controller, click this button and in the Physical Interface 
Controller dialog box, enter its enterprise name and click
OK.

The system assigns an ID to the controller when you save 
it to the database. The NIC can represent multiple 
physical devices. The limit is different for different client 
types. See the Cisco ICM Software Preinstallation 
Planning—Preparing Contact Center Systems guide for 
more information.

Delete Deletes the selected physical interface controller.
5-7
Cisco ICM Enterprise Editon Configuration Guide Version 6.0

78-11589-03



Chapter 5      Configuring Routing Clients
Configuring a Network Interface Controller (NIC)

 

 

 
 

 

 
 

 

Table 5-3 Routing Client Tab Descriptions

Field Description

Name (required) The enterprise name of the routing client associated with
the NIC.

You can have more than one routing client associated with 
a NIC. Typically, each routing client maps to a subsystem
within the interexchange carrier network.

Timeout threshold 
(required)

The maximum time, in milliseconds, that the routing 
client can wait for a response to a routing request. The 
NIC sends a default response slightly before this 
threshold.

Late threshold 
(required)

A threshold value, in milliseconds, for classifying 
responses as late. Any response that exceeds this 
threshold is considered late even if it does not exceed the 
Timeout Threshold.

Timeout limit 
(required)

The maximum time, in seconds, for which the routing client
waits for a response. This is the maximum time the routing
client will tolerate consecutive response timeouts before it 
stops sending requests to the ICM software. For more 
information, see Chapter 2, “How Routing Works.”

Default call type An enterprise name for the call type. Initially, you can 
leave this field blank. For information on this field, see the
Cisco ICM Software Scripting and Media Routing Guide.

Configuration 
parameters

A string containing any initialization parameters that must
be passed to the routing client. For a public network, this
might include the subsystem number.

A null value indicates no configuration parameters are 
provided.

Use DN/Label map Indicates whether the Dialed Number (DN) Label table is
used to determine which labels are valid for each dialed 
number. If not, all labels for the routing client are valid for 
all dialed number.
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How to modify a NIC and or its routing client(s) 

Step 1 Follow the preceding steps for viewing a NIC (See the “How to view a NIC and 
its routing client(s)” section on page 5-4). 

The selected NIC’s configuration information displays in the fields on the right.

Step 2 Edit the configuration information. (For field descriptions, see the “NIC Explorer 
Tab Descriptions” section on page 5-5.)

You can modify all fields in the logical controller, physical controller, and router 
client tabs that are not greyed out. 

When you make a modification, a Changed icon  appears next to the edited 
item (NIC or routing client) in the tree list box.

Step 3 Click Save.

Client type (required) The type of routing client that ultimately routes the call on
the requesting ICM system. 

This field is enabled only for the routing client associated 
with an INCRP NIC. In all other cases, it is the same as th
logical interface controller's client type.

See also “Sprint Routing Clients” on page 11 and “CRSP 
and France Telecom Routing Clients” on page 11.

Description Additional information about the routing client.

Network routing 
client

A name used to associate routing clients across instances.

The same string value for the routing client on the NAM 
and the corresponding routing client on the CICM 
(applies only for a network ICM.) For information on the 
Network routing client field, see the Cisco Network 
Applications Manager Setup and Configuration Guide.

Default Media 
Routing Domain

(selection list) The media routing domain associated with
the routing client.

Table 5-3 Routing Client Tab Descriptions (continued)

Field Description
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The modified data in the ICM database is saved and the Changed icon is removed 
from the display in the tree list box.

How to define a NIC 

Step 1 From the Configuration Manager menu, select Tools > Explorer Tools > NIC 
Explorer. The NIC Explorer window appears. 

Step 2 In the Select filter data box, click Retrieve. This enables the Add NIC button.

Step 3 Click Add NIC . A new NIC and its routing client display in the tree list box. Ne
to each is a To Be Inserted icon . 

On the right of the tree list box, tabbed fields also display for the new NIC’s a
routing client’s configuration information.

Step 4 Fill in the tabbed fields. (For field descriptions, see the “NIC Explorer Tab 
Descriptions” section on page 5-5.)

Step 5 If desired, set security settings on the records. (See the “How to view or apply 
security settings” section on page 3-22.)

Step 6 Click Save. The newly defined NIC is saved in the database and the To Be Inserted 
icon is removed from the tree list box.

How to define a routing client 

Step 1 Follow the steps for viewing a NIC. (See the “How to view a NIC and its routing 
client(s)” section on page 5-4.) The selected NIC’s configuration information 
displays in the fields on the right. 

Step 2 In the tree list box, select the NIC to which you want to add a routing client. T
enables the Add Routing Client button.

Step 3 Click Add Routing Client. A new routing client icon appears under the selecte
NIC in the tree list box and a new routing client tab appears in the window on
right.

Step 4 Enter the needed routing client configuration information in the fields on the 
right. (For field descriptions, see Table 5-3 on page 5-8.)
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Step 5 If desired, set security settings on the records. (See the “How to view or apply 
security settings” section on page 3-22.)

Step 6 Click Save.

Sprint Routing Clients

If you specify Sprint as the type of routing client, the NIC Explorer automatica
generates some additional records:

• An announcement named NPA_Blocked_Recording (if it does not alread
exist).

• A label named @NPA Blocked Recording associated with the generated 
routing client. The label type is Normal and the target is the 
NPA_Blocked_Recording announcement.

• A label named @Slow Busy associated with the generated routing client. 
label type is Busy.

These records provide support for Sprint’s NPA Blocked Recording feature and 
for returning a busy signal to the caller.

CRSP and France Telecom Routing Clients

• CRSP. If you specify CRSP as the type of routing client, the following tw
labels are automatically created by the NIC Explorer and are associated with
the new routing client:

– “ringForever” with a label type of 3 (ring)

– “busyForver” with a label type of 2 (busy)

• France Telecom. If you specify France Telecom as the routing client, the 
following three labels are automatically created by the NIC Explorer and are
associated with the new routing client: 

– @Interdiction

– @Fermeture

– @RenvoiForce

All three have the Label Type of 0 (Normal). 
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When a CRSP or France Telecom routing client record is deleted, the preceding
labels associated with the routing client are also deleted.

How to delete a NIC 

Step 1 Follow the steps for viewing a NIC. (See the “How to view a NIC and its routing 
client(s)” section on page 5-4.) 

The selected NIC’s configuration information displays in the fields on the right.

Step 2 In the tree list box, select the NIC whose records you want to delete. 

Step 3 Click Delete.

Step 4 This places a Marked for Deletion icon  next to the NIC in the tree list box. 
This also toggles the Delete button to Undelete.

To undelete a NIC marked for deletion, select it in the tree list box and click 
Undelete.

Step 5 Click Save.

This deletes from the database the NIC marked for deletion and removes it from
the tree list box. Once you do this, you cannot undelete the NIC. 

Configuring Dialed Number/Script Selectors
After you have set up a routing client, you need to define the dialed number/s
selectors serviced by it. A dialed number/script selector can represent an actua
number dialed by a caller or any string passed by a routing client to indicate the
number dialed. 

The Configuration Manager’s Dialed Number/Script Selector List tool allows y
to list the dialed number/script selectors currently defined in the ICM database, 
define new ones, and to view, edit, or delete the records of existing ones. The 
following instructions show you how to configure individual dialed number/scr
selectors. For configuring multiple dialed number/script selectors at a time, s
Chapter 4, “Configuring Multiple Records at a Time”.
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How to view, define, delete, or modify dialed number/script selectors 

Step 1 From within the Configuration Manager menu, select Tools > List Tools > 
Dialed Number/Script Selector List. The Dialed Number/Script Selector List 
window appears.

Step 2 In the Select filter data area, select the Routing client and Customer associated 
with the dialed number/script selector. 

Note Once you have saved a Dialed Number record to the ICM database, 
cannot update the Routing Client field.

If you are viewing or modifying a previously created record and you want to lim
the number of records retrieved from the database, also select one of the op
filters.

Step 3 Click Retrieve. This enables the Add button and displays a list of the retrieve
dialed number/script selectors.

The properties of the dialed number/script selector selected in the Dialed 
Number/Script Selector list box on the left side of the window are displayed in
property tabs on the right side of the window:

• The Attributes tab allows you to view and (if you have maintenance access
to define, edit, or delete the attributes of the selected dialed number/scr
selector. Attributes with an asterisk are required. Table 5-4 describes these 
attributes.

• The Dialed Number Label tab allows you to map labels (in addition to a 
default label) to the selected dialed number/script selector. Table 5-5 
describes the fields and buttons on this tab.

• The Security tab allows you to set security settings to the selected record. Fo
a description of how to use the Security tab, see Security Settings, page 3-22.

Step 4 This step depends on what you want to do:

• To add a new dialed number/script selector, click Add and enter the 
appropriate values in the tabbed property fields on the right side of the 
window.

• To delete a dialed number/script selector, select that number in the Dialed 
Number/Script Selector list box and click Delete.
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• To edit a dialed number/script selector, select that number in the Dialed 
Number/Script Selector list box and edit the appropriate values in the 
tabbed property fields on the right side of the window.

Step 5 Click Save to enter any edits into the database.

The dialog box closes, and for a new dialed number/script selector, the ICM 
database manager automatically generates a unique Dialed Number ID for the 
routing client.

Dialed Number/Script Selector List Tab Descriptions
The following tables describe the tabbed property fields and buttons that 
configure a dialed number record. 

Attributes Tab

Allows you to view and (if you have maintenance access) to define, edit, or delet
the attributes of the dialed number/script selector.

Attributes with an asterisk are required.

Table 5-4 Dialed Number/Script Selector Attributes Tab Descriptions

Attribute Description

Routing Client (required) (selection list) The enterprise name of the routing client 
associated with this dialed number/script selector. Once you 
select a routing client and save to the database, this field 
becomes read only.

Dialed number/script 
selector string (required)

The string value by which the routing client identifies this 
dialed number/script selector. This must be the value the 
routing client passes to the ICM software for calls to this 
number. For example: 8005551212.

Name (required) The enterprise name for the dialed number/script selector. This 
name must be unique among all dialed number/script selectors 
in the system.
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Dialed Number Label Tab

Allows you to view, add, or remove the mapping of labels to the selected dia
number/script selector. These are additional to the default label assigned in the
Attributes tab.

Note The Dialed Number Label tab is enabled only if the routing client for the selected
number/script selector has the Use DN/Label map box checked in the routing 
client tab of the NIC Explorer.

Media routing domain 
(required)

(selection list) The media routing domain associated with the 
selected dialed number/script selector. 

Customer (optional) (selection list) The customer associated with the 
dialed number/script selector. 

Default label (optional) (selection list) The name of the default label for this 
dialed number/script selector. The label must have been 
previously defined for it to be in the selection list. Use the 
Configuration Manager’s Label List tool to define labels. 

If ICM software fails to determine a target for the call within the 
routing client’s time-out threshold, then the default label for the 
dialed number/script selector is used.

Description (optional) Additional description for the dialed number/script 
selector.

Table 5-4 Dialed Number/Script Selector Attributes Tab Descriptions (continued)

Attribute Description

Table 5-5 Dialed Number Label Tab Descriptions

Column/Button Description

Name This list contains all the Labels currently assigned to the selected dialed 
number/script selector.

Description Additional information about the label.
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